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Foreword  

The South African Environmental Observation Network (SAEON) invests in capacity development 

programmes for senior grades’ educators through their environmental science education 

programmes (ESEP). These programmes are aimed at enhanced teaching and learning that promote 

critical thinking. In 2011, Geographical Information Systems (GIS) was introduced into the Curriculum 

Assessments and Policy Statements (CAPS) in high schools across South Africa. SAEON through its 

interaction with Geography educators established that educators needed assistance with training in 

Geographical Information Systems (GIS). 

The teaching of new technologies in education such as GIS requires an investment in training to 

upskill educators in the incorporation of hardware and software. In developing this GIS training 

programme, SAEON conducted a needs analysis to determine what resources are available in a 

school setting for a GIS capacity building programme to be effective. The underwhelming availability 

of resources particularly at rural schools prompted SAEON to firstly create an educator capacity 

development programme in GIS that uses paper plotting activities to provide meaningful learning 

opportunities for learners who do not have access to computers. This GIS training manual thus 

incorporates learning-centred activities to educators that they can use or adapt to promote inquiry 

and paper-based teaching strategies.  

Despite the obvious challenges, the Department of Basic Education is promoting the integration of 

technology into the South African classroom. Through the first edition of this training manual, 

SAEON will also support senior Geography educators who have access to computers to develop the 

necessary skills in the use of QGIS open software. Training in the use of the software will allow them 

to implement technology-based teaching activities and to have open access to the latest data and 

computing technology. 

We wish all educators and trainers a rewarding journey when adopting this manual. Your feedback 

will be essential for the improvement of further editions.  

Moreover, we wish the high school learners who will ultimately benefit from their newly upskilled 

Geography teachers, great success in applying the power of GIS technology across a wide range of 

careers. 

 

Managing Director: South African Environmental Observation Network (SAEON) of the National 

Research Foundation (NRF) 

56 Florence Street, Colbyn, Pretoria, 0083 

SAEON is a comprehensive, sustained, coordinated and responsive South African environmental 

observation network that delivers long-term reliable data for scientific research and informs 

decision-making; for a knowledge society and improved quality of life 

www.saeon.ac.za  

Twitter: @Saeonews 
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Introduction 

 

The science of Geography is one of the oldest professions in the world. For as long 

as people have been aware of the world around them, we have tried to describe the 

way that one place is related to another. This has been achieved through verbal 

descriptions of where to go, through stories, paintings, and legends. These have all 

served as a way of describing how one place relates to another and provides us with 

information about that place. This means that they provide spatial information or 

spatial data about a place. 

 

More recently, maps were used to create a simplified representation of the world, 

which enabled people to navigate the land and oceans and told people what to expect 

about their eventual destination. As science has progressed, our ways of describing 

our world have become more and more complex, with tools being able to provide us 

with detailed information about a place in both space as well as time through 

technologies such Global Positioning Systems (GPS) and Databases. These 

technologies and the rise of personal computers and smartphones have enabled 

everyone to be able to use spatial information in order to understand the world around 

them.  
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Linking GIS concepts to Curriculum and Assessment Policy Statements 

(CAPS) 

 
Subject content 
knowledge as 
per CAPS 

G
ra

d
e
 

T
e

rm
 

P
a

g
e
 

Assessment 
(To assess learner's 
skills on:) 

Assessment 
activities 

Activity 
in 
manual 

Concept of GIS. 
10 1 10, 

11 
Defining GIS  Describe GIS.   

Reasons for the 
development of 
GIS. 

10 1 7, 
11 

Identifying GIS 
applications  

 What are some of 
the uses of GIS? 

 Think of a question 
that GIS can help 
answer 

 

Concept of 
remote sensing.  

10 1 20 Defining remote 
sensing and 
Identifying its 
applications 

 Describe remote 
sensing? 

 Identify remote 
sensing applications 

 

How remote 
sensing works? 

10 1 20-
21 

Comparing, 
differentiating 
between and giving 
an example of the 
types of remote 
sensing techniques 
(passive and active) 
and data (raster and 
point cloud).   

 Differentiate 
between active and 
passive remote 
sensing  

 Differentiate 
between point cloud 
and raster images  

­ Give examples of 
each 

 

GIS concepts: 
spatial objects, 
lines, points, 
nodes and 
scales. 

10 4 13 
– 
15 

Defining, identifying, 
differentiating 
between and giving 
an example of 
different types of 
vector data  

 Define the different 
types of vector data 
(point, line and 
polygon/shape)  

­ Give examples of 
appropriate features 
that each could 
represent 

 Calculate the 
distance on a map 
using a scale 

­ Between two points; 
or distance of a 
river/road 

2 

Spatially 
referenced 
data. 

11 2, 
4 

1, 
10 

Defining spatially 
referenced data and 
contrasting the 
different types of 
data (spatial verse 
attribute data) 

 Define the spatially 
referenced or 
geographic data 

 Compare spatial and 
attribute data  

1 
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Spatial and 
spectral 
resolution. 

11 2, 
4 

21-
23 

Defining resolution   Define resolution 
­ Define spatial 

resolution 
­ Define spectral 

resolution 

5 

Different types 
of data: line, 
point, area and 
attribute. 

11 2, 
4 

13 
- 

15 

Defining, identifying, 
differentiating 
between and giving 
an example of 
different types of 
data 

 Define the different 
types of vector data 
(point, line and 
polygon/shape)  

­ Give examples of 
appropriate features 
that each could 
represent 

 Define attribute data 

1 and 2 

Raster and 
vector data 

11 2, 
4 

15 Defining, identifying, 
differentiating 
between and giving 
an example of raster 
and vector data 

 Define vector data  
­ Give examples of 

what features this 
type of data could 
appropriately 
represent 

 Define raster data  
­ Give an example of 

what type of data 
would be most 
appropriate as a 
raster data 

 

Capturing 
different types 
of data from 
existing maps, 
photographs, 
fieldwork or 
other records 
on tracing 
paper. 

11 2, 
4 

9, 
13 

Interpreting 
maps/photograph 
and identifying 
features on a 
map/photograph  

 On a 
map/photograph 
identify an example 
of a polygon, line or 
point  

­ Using string or a 
whiteboard marker 
on blank 
transparency to 
represent a polygon 

­ Using string or a 
whiteboard marker to 
represent a line 

­ Using a pin or a 
whiteboard marker to 
represent a Point 

2 and 
Appendix 

B 

Application of 
GIS by 
government 
and the private 
sector, relate to 
weather and 
settlement 
topics above. 

12 2 13-
15 
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Developing a 
“paper GIS” 
from existing 
maps, 
photographs or 
other records 
on layers of 
tracing paper. 

12 1, 
2, 
3 

 Interpreting 
maps/photograph 
and identifying 
features on a 
map/photograph 

 Identify features on 
an aerial photograph 
or map that could be 
represented as a 
polygon, line or 
point.  

2 

GIS concepts: 
remote-sensing 
and resolution 

12 2, 
3 

20-
23 

Defining remote 
sensing and 
Identifying its 
applications. Defining 
resolution 

 Describe remote 
sensing? 

­ Identify remote 
sensing applications 

 Define resolution 

 

Spatial and 
attribute data; 
vector and 
raster data. 

12 2, 
3 

15  
Defining, 
differentiating 
between spatial and 
attribute data.  
Defining, identifying, 
differentiating 
between and giving 
an example of raster 
and vector data 

 Contrast spatial and 
attribute data 

 Define the different 
types of vector data 
(point, line and 
polygon/shape)  

­ Give examples of 
appropriate features 
that each could 
represent 

 Define raster data  
­ Give an example of 

what type of data 
would be most 
appropriate as a 
raster 

1 and 2 

Data 
standardisation, 
data sharing 
and data 
security. 

12 2, 
3 

16-
17 

  Why is data 
standardisation 
important? 

­ Can you compare 
data in different 
formats? 

 Why is data shared? 

 Why is data security 
important? 

 

Data 
manipulation: 
data 
integration, 
buffering, 
querying and 
statistical 
analysis. 

12 2, 
3 

17-
19 

Applying GIS 
concepts, 
investigating and 
extracting information 
to answer a question.  

 What do you need to 
consider before 
integrating data from 
different sources? 

3 and 4 
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Spatial data 

 

In order for us to understand GIS, we need to understand a bit about spatial data. 

Spatial data is information that has some form of geographical location associated with 

it. For example, a street address, place name, GPS co-ordinates, geotagged photos, 

tweets, location tags on Facebook or Instagram and Census data all are spatial data, 

even your cell phone photos can have a location attached to it. 

 

 
Examples of tools that we use to understand and record our world. 

 

As most people are very visually orientated, we like to represent the world around us 

in some sort of visual way and in order for us to easily represent what we see in a way 

that other people can understand where something is. How things relate to each other 

spatially, we may use maps in our day-to-day lives like Google Maps on your cell 

phone or topographic maps for your learners in Geography. 

 

 
Examples of an Oblique (Side view) Aerial Photograph and a vertical (Bird’s 

eye view) Aerial photograph. 

 

  

Photo by Patrick Brinksma on Unsplash   Photo by ShareGrid on Unsplash 
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Maps 

 

A map is a way of telling us information about an area. Often it is a vertical photograph 

of a place with additional information added (such as labels of place names) or it can 

be a representation of a place that has been simplified for it to be easier for us to 

understand. 

In the example below, we can see two maps, one with place information on an aerial 

photograph, and another with street and place names. As we can see, the types of 

information we receive from these two different kinds of maps varies however, both 

are useful! 

 

 
Two different maps of the same place (Nelspruit/Mbombela) 

 

Why do we create Maps? 

 

• Shows us the important physical features  

• Features are both natural and man-made e.g. rivers, mountains, school, church  

• Assists in finding a particular location  

• Quite simple to use  

• It can be customised to suit the audience e.g. tourist map vs. map of a town  
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Type of Feature  Description  

Cultural Features  Airports, roads, buildings, infrastructure 

Hydrography features Rivers, streams, lakes, dams,  

Relief and Mountains  Mountains, valleys, cliffs, contours 

Vegetation  Forests and Nature Reserve   

 

 

Different types of Maps  

Shaded relief map 

 
A shaded relief map that shows us features such as mountains, slopes, etc. with the 

flat areas appearing smooth and steep areas appearing rough on the map.  
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Topographic Map: Luchaba Wildlife Reserve 

 

 

 

Road Map: roads of a city and a town
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Tourist Map: features such as tourist’s monuments or places of interest for 
tourists. 

 

 

3D Maps: information in three dimensions showing the features such as the 

elevations of a landscape.  
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Use of Maps  

 

 
 

Interpreting a Map  

 

When a map is analysed, the features can be distinguished through colours, lines and 

other symbols.  Features are shown as points, lines or areas. The size and type of the 

feature depends on whether a feature is represented as a point, line or area - these 

types of data are called Vector Data and we will explain these concepts in detail in the 

GIS section. 

 

As all maps are a representation of something in the real world, a true map will always 

have the following: 

 

 

Use of Maps 

Improves the 
understanding of a place  

Location: 
Where are we?

Maps gives us our location 
relative to other features in 

the surrounding. Map 
provide info on the latitude, 
longitude and coordinate 

system to measure all 
places on Earth. 

Navigation:
Where are we going? 

Maps provide information 
on travel routes. It enables 
one to navigate from one 

place to another and back. 

Information: 
What else is there?

Besides roadmaps and 
topograhic maps there are 
thematic maps. Maps of 
rainfall, temperatures, 
diseases, etc. provide 

information on a specific 
topic.  

Exploring: 
Where do we go from 

here?
Innovations in science and 
technology as changed the 
ways data is acquired and 

the techniques used for 
mapping such as remote 

sensing, GIS,  GPS, digital 
photogrammetry. 
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The scale of a map controls the amount of information that a map contains. The scale 

defines the relationship between the mapped magnitude and the actual magnitude. 

On the map, the linear distances are shown as a ratio of the actual ground distance. 

In the example below, the scale bar shows that the distance represented by the length 

of the scale bar represents 2 km in real life. 

 

 
Orientation for positioning a map so the top, for example, points either magnetic or 

true North. When you orient a map and know where you are on the map, you can look 

in a certain direction, see a real landmark, and find it on the map. 

 

 
A symbol on a map is defined by the map’s legend. An area feature represented by 

green illustrates vegetation, blue is for water and the built up area is grey or red. Lines 

such are curved, dotted or dashed or a mixture of them are used to indicate different 

features. 
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Additionally, maps can provide you with information about the landscape surface, for 

example, contour lines can tell you about the shape and slope of landscape features 

such as hills, valleys, and mountains. These are called three dimensional surfaces: 

3 D surfaces are illustrated in three-dimensions to ensure that the elevation value is 

not lost on the map. An example of a three-dimensional surface is a terrain that is 

shown by contour lines that have an elevation value. 

 

Geographic Data  

 

Activity One  

Each participant is given a card that has information on the card. The participant will 

describe the information on the card and the other participants will determine the 

point of interest.  

Card 1 

 

Card 2 

 
A rest camp: 24.9948° S, 31.5969° E 33.9628° S, 18.4098° E 

A National Park in South Africa that lies across 
two provinces. This park was open in 1927 and 
is home to approximately 93 mammal species, 
518 bird species and 118 reptile species. 
 
 
 

A flat topped mountain forming a prominent 
landmark overlooking a city in South Africa. 
Tourists use the cableway or hike up this 
mountain. This mountain is home to fauna and 
flora, most of which is endemic. 
 

 Who am I?  Who am I? 

 What is the name of the province/s that 
you would find me in? 

 What is the name of the province/s that 
you would find me in? 

  

Photo by Matthias Mullie on Unsplash https://sataracamp.com 

https://en.wikipedia.org/wiki/Mountain
https://en.wikipedia.org/wiki/Endemism
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Card 3 

 

Card 4 

 
28.7391° S, 24.7585° E 33.8076° S, 18.3712°E 
Thousands of prospectors with picks and 
shovels came here and created what claims to 
be the largest hand dug excavation in the world. 
People are contesting that I am not the largest 
hand dug excavation in the world. 
 
 

I am an island in Table Bay, 6.9 kilometres west 
of the coast of Bloubergstrand. My shape is 
roughly oval 3.3 km long north-south, and 1.9 
km wide, with an area of 5.08 km2. 

 Who am I?  Who am I? 

 What is the name of the province/s that 
you would find me in? 

 What is the name of the province/s that 
you would find me in? 

Card 5  

 

Card 6  

 
25.9254° S, 27.7674°E 34.0169° S, 23.8574° E 
Just 50km away from Johannesburg, there is a 
complex of limestone caves. In these caves, 
scientists have discovered fossils that date back 
to the birth of humankind. The most famous 
among the fossils are the skull 'Mr. Ples' (which 
is a 2.1 million-year-old skull) and the skeleton 
'Little Foot' (which is 3 million-years-old). 

A National Park in an area of the Garden Route 
on South Africa’s southern coast. It 
encompasses a marine reserve, deep gorges 
and local vegetation like the Big Tree, a 
towering yellowwood. The Mouth Trail crosses a 
suspension bridge over Storms River. 

 Who am I?  Who am I? 

 What is the name of the province/s that 
you would find me in? 

 What is the name of the province/s that 
you would find me in? 

  

Photo by South African Tourism on Flicker Photo: Caitlin Ransom  

Photo by South African Tourism on Flicker Photo by FrancoisMalan on Flicker 
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Card 7 

 

Card 8  

 
23.6362° S, 30.3463° E 

 

29.0967° S, 26.2362° E 

This reserve is situated in Lobedu Mountains, 
home of the Modjadji rain queens. In this 
reserve, you would find the highest 
concentration of a single species of cycad with 
featuring some of the oldest and largest cycad 
specimens on earth. 
 

Gaze up at the mysteries of the universe in the 
first digital planetarium in Sub Saharan Africa. 
Opened in 2013, this digital planetarium 
provides a digital experience from the smallest 
atomic particles to the largest cosmological 
scales. 

 Who am I?  Who am I? 

 What is the name of the province/s that 
you would find me in? 

 What is the name of the province/s that 
you would find me in? 

Card 9 

 

Card 10 

 
26.2348° S, 27.9827° E 29.8672° S, 31.0463° E 

 
This is the largest stadium in South Africa which 
seats 87 436 spectators. The unique design of 
this stadium is often referred to as the 
“Calabash” or “African Pot”. 

The aquarium is the 5th largest in the world, 
with 32 tanks totalling 17,500 m3 of water. The 
underground aquarium is designed around five 
shipwrecks, with its entrance through the above-
ground "Phantom Ship". The fantastic dolphin 
stadium can seat 1,200 visitors, and the seal 
stadium can seat about 450. 

 Who am I?  Who am I? 

 What is the name of the province/s that 
you would find me in? 

 What is the name of the province/s that 
you would find me in? 

 

At the end of the activity, the concepts of spatial data and attribute data is introduced which is 

leads us to the next section of this training manual.  

 

 

  

Photo by Pascal Parent on Flicker 
https://commons.wikimedia.org/wiki/File:Naval_

Hill_-_Bloemfontein_-_Planetarium.jpg 

Photo by South African Tourism on Flicker Photo by Gary Craig on Flicker 
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Geographic data is the information that we gather about the world around us. 

 

 It can be the name of a place (point). 

 

 The length and direction of a road or river (line). 

 

 The size and shape of a farm, school ground, province, mountain (polygon - a flat 

figure consisting of connected straight lines). 

 

All geographic data has a position and attributes which describe to us what that data 

is. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Attribute Data 

 Where is it? 

 Location of a feature or a 

phenomenon through the use 

of a coordinate system 

 The spatial or geospatial data 

is stored as coordinates or 

topology. Spatial or geospatial 

data can be mapped 

 Information about the 

properties at a geographic 

position 

 What is it? 

 Properties of spatial entities  

 Examples  

o Identity: maize, river 

o Ordinal: ranking eg. class 1, 

class 2 

o Scale: depth of water, 

erosion rate 

 Frequently referred to as non-

spatial data as they do not 

contain information on the 

location 

 Spatial Data 

Geographic Data 
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Concept: GIS 

 

GIS is the abbreviation for Geographical Information Systems. 

 

Basically, it is a tool that enables us to analyse information and spatial relationships 

between different geographic datasets, it enables us to take the information that we 

gather about the world around us and use it to answer questions and solve problems, 

enabling us to make our own maps. 

 

For example, you could use a GIS in order to answer this question: How many 

emergency services are there that are within 10 minutes’ drive from your school? 

In order to answer this question, we would use the location of the different emergency 

services in a region, and see how far away they are from the school by plotting the 

routes that a car or ambulance would take in order to get from the school to the 

emergency service point (hospital, fire station, clinic, etc.). Thereafter we could then 

calculate how long each of those routes are (distance) and then calculate the time it 

would take for an ambulance to get from the school to a hospital. We can then discard 

any routes where the time taken takes longer than 10 minutes. We can then see how 

many of those routes wind up at different hospitals and we would have our answer! 

 

Now, answering the above question using a pen and paper map would take a long 

time, but it is easy to do when using a GIS on a computer system. 

 

GIS brings together layers of information about a place so that we can better 

understand that place. The types of analyses we will perform will vary depending on 

the types of problems we are trying to solve. When bringing together the different 

layers of information, the purpose of the analysis will determine how datasets are 

combined and analysed. GIS is a computer based programme that collects, stores, 

manipulates and displays geographic information, but the techniques and concepts 

that we will be applying date back to the first cartographers making maps. 

  

History of GIS 

 

GIS is an extension of cartography and the concept began through trying to 

understand cholera outbreaks in Europe during the 19th century. In 1854 John Snow 

discovered that London cholera outbreaks were concentrated around a water pump, 

by marking outbreaks on a map. This was the beginning of spatial analysis. GIS has 

since evolved from paper maps to the concept of layers, through the use of 

transparencies, and now to computers. Roger Tomlinson pioneered GIS through his 

role in developing the Canada Geographic Information System (CGIS). The CGIS 

aimed to integrate natural resource data to create a Canadian national land use 

management program. The improvement in computers and the advantages of GIS 

lead to commercialisation of software in the 1980s. Today GIS gives people the ability 

to solve real world problems by creating their own maps by combining different sets of 

data relevant to each problem.  
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Key Components of a GIS 

 

 
 

 

 

 Hardware  

­ A computer is the hardware from which the GIS is used.  

­ Examples include: CPU, monitor, keyboard and drivers, scanners and 

digitisers 

 Software 

­ GIS software makes available the functions and tools to store, analyse and 

display geographic information 

­ Tools for input of data and manipulation of data 

­ Database Management Systems (DBMS) 

­ Tools that support geographic query, analysis and visualisation 

­ Graphical user interface (GUI) to access the tools easily  

 Data Processing  

­ The most crucial factor that is costly for GIS is data. Building a database 

costs money, time and requires lots of planning and management. GIS can 

work effectively if data is readily available at an affordable cost.  

 People 

­ GIS technology cannot be utilised without people to manage the system.  

­ The technical specialists design and maintain the system.  

­ Others users are people that use it to help them in their work eg. scientists, 

engineers, town planners.  

­ Skills needed by people who use GIS is that they need to think spatially.  

 Policies and Procedures 

­ Well-designed plan and business rules are important in making decisions 

such as choosing the right GIS for a particular implementation 
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What can GIS do? 

 

• Location: GIS can provide information on what can be found at that specific 

location. A location is described by using different methods eg. postal code, 

name of the place, longitude/ latitude or x and y. 

• Condition: Given a certain condition, such as an area of 2 000 square metres 

of forest, you can use GIS to find the location for that particular condition.  

• Trends: What has changed in an area with time? Has the forest cover changed 

over the past ten years?  

• Patterns: What spatial patterns are there?  At which intersections are accidents 

happening most often?  

• Modelling: GIS uses specific models to answers questions. What would the 

impact be if a new road is added?  

 

Activity Two 

2.1.1. Create a map of Africa using the string. 

2.1.2. Use string or raffia to illustrate any river that you know of in Africa on the map 

that you have drawn from the string. 

2.1.3. Place the drawing pin on a location of a country in Africa that you have visited 

or that you would like to visit. 

Data Capture:  
Data used in GIS is 

captured from many 

diverse sources, 

many types of 

different   tools and 

stored differently. 

Tools and techniques 

in GIS allow for data 

to be combined into 

formats were data 

can be compared and 

examined.  

Data Management: 

GIS provides data 

management through 

data security, data 

integrity, data 

storage, retrieval and 

data maintenance.  

Spatial Analysis:  

GIS has functions 

such as spatial 

interpolation (where 

you have values of 

something and you 

use it to estimate 

other values. For 

example, you have 

rainfall data for 

certain places where 

there is weather 

station service 

equipment and you 

use this data to 

estimate), buffering 

and overlay.  

Presenting Results: 

GIS can present 

results in numerous 

ways such as 

tabulating and 

graphing data, maps 

and three 

dimensional images. 

Exploratory, 

cartography and 

scientific 

visualisations are new 

ways to communicate 

results. 

GIS Functions 
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Participants would then be given an A4 map of Africa on a transparency to determine 

if the map that they have created is the correct shape, the river is placed correctly and 

their pin is on the country they have visited or would like to visit. The shape that has 

been created from the string of Africa is called a polygon or shape in GIS. The river 

has a start and finish point and in GIS this is known as a line. Other examples of lines 

on a map would be roads, trails, and pathways. The location of a place that they have 

visited or intend to visit, in GIS we call this a point and it is given by a single set of x 

and y coordinates. This activity links to the concepts of vector data which is defined in 

the next section of this training manual. 

 

The above activity was adapted from National Geographic Website: 

https://www.nationalgeographic.org/activity/introduction-gis/ 

 

Picture of a Map showing Points, Lines and Polygons  

 

https://www.nationalgeographic.org/activity/introduction-gis/
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Raster and Vector Data  

 

The spatial features in GIS are stored either in vector or raster form (data).  

 

Vector Data 

The position of map features is stored in coordinates x (longitude), y (longitude) and 

occasionally z (Height). The vector format indicates the location and shape of features 

and boundaries accurately. 

 

Point: A single location that illustrates the location of a feature. A point feature location 

may be characterised by a single x, y or x, y, z location. Points have no linear or area 

dimensions. Examples of point features are a point were something occurred or a 

single point showing a monument or a place of interest. 

 

Line: A line joins two points to illustrate the start and finish of a feature. There is no 

area in a line feature. An example of a line feature is the centre line of a road or a river.  

 

Shape or Polygon or Area: A shape that has three or more sides and is on a plane 

(flat) is defined as a polygon in mathematics. In GIS a polygon or shape is a figure that 

are on a plane were the first and last coordinate pair is the same. The shape / polygon 

/ area feature is characterized by two dimensions that is enclosed by a boundary line 

that contains the area. 

 

Raster Data 

Data that has a grid-based format in which map features are shown as cells or pixels 

in a grid matrix. Pixels are the smallest unit in which raster data is stored. The space 

is defined by points or cells that are arranged into rows and columns. The position of 

each element can be given if the rows and columns are numbered. The row number 

and the column number can be linked to coordinate positions that form the coordinate 

system. Every cell or pixel has an attribute value (a number) that represents a 

geographical phenomenon or nominal data e.g. rainfall or elevation.   

 

The size of the grid will determine the level of detail in which map features can be 

specified. 

 

Sensors from satellites and airborne instruments provide raster data which is made up 

of pixels. Raster data is used to illustrate elevations using pixels. The resolution of an 

image is the pixel size in raster data. The “minimum mapping unit” is the smallest 

object that can be identified. 
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Raster image from a satellite of a veld fire near Simonstown in the Western Cape. 

 

Activity Three 

 

3.1.  Use the set of transparencies provided and answer the questions below: 

3.1.1. Set the layers.  

3.1.2. Identify which province has the most number of district municipalities? 

3.1.3. Identify which province has the least number of district municipalities? 

3.2. QGIS is an open source GIS software, meaning that it is free for anyone to 

download and use. Now use QGIS to answer the questions in 3.1. Appendix B 

(page 40) is a user guide for you to follow. 
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Data standardisation 

 

When you look at the ID number of a South African citizen, the ID number starts with 
the first two digits being the year in which you were born, the next two digits being the 
month in which you were born and the next two digits being the date on which you 
were born. All ID numbers in South Africa have 13 digits. Did you ever wonder why 
this is so? The data for the ID is put in a format that has meaning to any person reading 
the ID number and this is known as data standardisation. 

When data is sourced you will find that there are different formats in which data is 
stored. When data is shared, it is problematic for users if the data is in different formats. 
Geography Markup Language (GML) is the standard for spatial data for the South 
African Government’s Minimum Interoperability Standards (MIOS). Interoperability is 
the ability of different systems to work together. 

 

Data sharing 

 

Data is collected from different sources such as local government, provincial 

government, and national government. The benefits of sharing data can reduce costs 

amongst different government departments.  

The most effective way to share data would be through the internet. Data can be 

shared through: 

• Shared folders or directory  

• Use URLS to download full data sets as files  

• Email for small data files  

• Web services such as Web Map Services (WMS) and Web Feature Services 

(WFS) 

• Connect to a database where the spatial data is stored  

• Application Programming Interface (API) which the developer gives access to 

the user for the content  

 

Data security 

 

Data security refers to the confidentiality and integrity of the data. In South Africa, 

certain government data is accessible to the general public. Security measures are 

put in place to ensure data security. Some of the security measures are database or 

file system, web services or application. There are numerous ways that data security 

is applied eg. read-only access, write or edit access, access to delete data sets or 

create new ones. 
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Data manipulation and application of GIS Techniques 

 

Data is manipulated by changing or reorganising the data to make it more beneficial 

for the user.   

• Editing by changing the features or moving the features around  

• Linking of data sets for integration  

• Simplifying the data  

• Adding or removing attributes   

 

Data integration 

 

Data integration is combining data from different sources and providing an integrated 

interpretation of the data to the user. The questions that need to be answered when 

doing a GIS project is: 

• What type of data do I need?  

• Where can I get the data? 

• What map layers do I need? 

 

Prior to integrating data, you need to ensure that: 

• Data is in the correct format  

• The data is cleaned and the data is of high quality 

• The projection and coordinate reference system is chosen 

 

Data standards for quality  

• The data fields or attributes contain the content that is needed for the GIS 

project 

• The geometry is correct. For example, if a polygon is not closed, it means that 

the coordinates of the polygon at the start and finish are not the same and this 

polygon cannot be used. A polygon cannot be used if it is intersecting itself.  

 

When data is integrated it is crucial that the map layers are overlaid accurately. The 

alignment needs to be correct so that all layers provide correct information. The layers 

must align themselves in their rightful geographic positions.   

 

How can you make sure that layers are aligned? 

 

• Coordinate reference system (CRS) refers to how your map that uses 

coordinates is drawn in GIS is viewed in relation to the places on earth.   

Using different CRS between layers is the main culprit if layers are not aligned. 

The type of CRS to use depend on where you want to work and the analysis 

you want to do.  

• Here are some ways you can make sure your layers are aligned: 

- CRS of the geometry needs to be defined accurately.  

- Geometry should be in CRS defined above  

- CRS for the project should be understood by GIS software or the GIS 

software should change the data to the CRS that is being used 
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Analysis – Buffering 

 

Buffering is when you make a zone of which the distance is specified from the original 

feature’s edge and that zone is called the buffer zone. The buffer zone is made around 

features such as a point, line or polygon feature. Buffer zones are created for 

environmental protection, protection of people from natural disasters, etc. 

In the following exercise, we are going to use buffers in order to solve a problem. 

 

Activity Four 

 

4.1. When farmers use river water to irrigate their fields, the further away from the 

river the field is the more expensive it is to water that field. Using the imagery 

given to you, answer the questions in the below activity.  

4.1.1. How many circular fields are within 500m of the river? 

4.1.2. How many circular fields are within 1km of the river? 

4.1.3. Which Buffer (500m, 1km or 2km) contains the most circular fields? 

4.1.4. The fields of which Buffer are going to be the cheapest to pump water  to? 

4.1.5. The fields of which Buffer will be the most expensive to pump water to? 

4.2. Appendix B is a user guide for you to follow the steps to be able to answer 

activity 4.1 using QGIS.  

 

Querying 

 

Querying is to retrieve the attribute data that has been specified by the user and this 

attribute data must satisfy the criteria set by the user. Eg. data that show rivers that 

are less than 10 000m in length.  

 

In the example below all Fields within 500m of the river were selected using the 

following SQL query: 
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Statistical Analysis 

 

The data in a spreadsheet or database field is the same as spatial data attributes or 

fields. Statistical functions used to analyse data in a spreadsheet can be used in GIS. 

Statistical techniques that can be used in GIS are:  

• Distribution: eg. Distribution of fish species in the ocean  

• Classification: eg. Urban or Rural  

• Patterns: eg. Rainfall patterns in different provinces  

• Aggregation or summaries: eg. The elevation of the catchment area  

 

Remote Sensing 

 

We use our five senses to understand the world around us. The sense processes are: 

 

       

 

    

 

   

 

  

 

   

 

 

 

 

 

 

 

 

 

Close contact with objects allows one to touch and taste. However, to see or hear we 

do not need close contact with an object and in this instance, we are remote sensing 

as we are gathering information about an object without physically coming into contact 

with it. 

 

Remote sensing can be defined as collecting information through recording, 

observations, sensing objects or events without direct contact. Remote sensing allows 

for information about the Earth to be collected from a distance. Remote sensing is 

done from aircrafts and from satellites that are orbiting at distances from a few hundred 

to 36 000 kilometres above the Earth. 

 

Seeing  

Hearing 

Smelling 

Touching  

Tasting  
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Types of Remote Sensing  

Passive Remote Sensing Active Remote Sensing 

The source of energy is the sun or 
earth/atmosphere  

The source of energy is part of the 
remote sensory system called Radar  

Wavelengths of the sun are 0.4-5μm.  
Wavelengths of the earth or atmosphere 
are 3 μm-30 cm  
 

Wavelengths of the radar are in mm-m. 
These include ultraviolet, visible, and 
near infrared wavelengths.  
 

 

Remote sensing data types – raster and point clouds 

 

Remote sensing datasets come in 2 types. Point clouds or as raster images.  

 

Point clouds are three-dimensional (3D) datasets that get created by scanning the 

world with a laser range finder or LIDAR system. Each place that the laser scans is 

then added to a dataset that gives us the GPS co-ordinates and height above sea level 

for each point. This enables us to build 3D models of the world. 

 

This type of data is not very common as it is expensive to generate, however as 

sensors become cheaper we will probably see more and more uses for this 

information.  

Image of a satellite collecting data Image of an aircraft collecting data 
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 Resolution 

 

Resolution is defined as the size of the unit of measure. It can be broken up into 

different classes, being spatial, temporal and radiometric resolution.  

 

Spatial resolution: is the smallest object that a sensor can resolve. Spatial resolution 

refers to on the ground linear dimension of each pixel or grid cell.  Spatial resolution 

indicates the amount of detail that is found in a map or image. In the example below, 

the first image has a coarse resolution, i.e. one pixel of the image represents an area 

17km long by 17km wide! As you can see, with coarse resolution images it is difficult 

to see detail in the picture. The far right image has a resolution of 1km so one pixel of 

the image represents an area 1km by 1km. This enables us to see a lot more detail. 

Some satellites have a resolution of 3cm. But, the problem with working with very high 

resolution images is that the images take up a lot of storage space on a computer and 

are difficult to process due to their size.  

 

Activity Five 

 

Which picture (above: A, B or C) has the highest spatial resolution? Give a reason for 

your answer.  

 

 

A B C 



32 

 
Spectral resolution: tells us the specific wavelengths within the electromagnetic 

spectrum that the sensor can record as information.  

 

 
Temporal resolution describes how a sensor can get an image of a particular place 

of interest. Eg., a satellite passes a certain location every 48 hours and images are 

only processed every 48 hours.  
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Radiometric resolution tells us the amount of brightness values that is likely in every 

band of data and is calculated by the number of bits into which the recorded energy is 

divided into. 

 

Conclusion  

 

This manual in conjunction with the appendices can be used to teach GIS using paper 

based activities. The link for the QGIS software has been provided together with the 

data for the activities 2 to 4. We suggest that when teaching each section, start with 

the paper based activity. Thereafter get learners to implement the same activity using 

QGIS (if your school has access to computers).  

 

We encourage you to use QGIS to teach GIS in your classrooms as this is free 

software and can be installed on computers in your lab. 
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Appendix A: Creating your own spatial datasets in Google Earth Pro 

 Google Earth is a geospatial software application that combines satellite images, 

aerial photography, and GIS data. Google Earth allows users to explore the globe, 

using a computer and the internet.  

The Google Earth Pro desktop application can be downloaded at: 

https://www.google.com/earth/versions/download-thank-you/?usagestats=1.  

Please note that you need to be connected to the internet for the images to load.  

 

Manual Digitising in Google Earth  

Google Earth offers high resolution imagery that can be used for digitising land 

features and for ground truthing (validation of land cover classification).  

 

1 – The left panel contains “Search” (for searching locations), “Places” for locations 

that have been digitised or saved, and “Layers” for layers of information and features 
that Google Earth offer – you can switch them on and off by clicking the small check-

box next to each feature.  

 

2 – The top panel of the Google Earth interface includes 14 buttons which allows you 

to do various tasks. Hover (the cursor) over each button to see what it does.  

 

3 – The top right corner is a navigation panel, which lets you navigate around the map 

and move it in all directions and angles. The bigger navigation circle with an eye in the 

centre and “N” on top (denoting “North), allows you to tilt the map up, down, left and 

1 

2 

3 

https://www.google.com/earth/versions/download-thank-you/?usagestats=1
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right. Clicking the “N” will bring the map back to its “true North” position. The second 
and smaller navigation circle with a hand in the centre lets you pan/move the map up, 

down, left and right. The orange standing man icon shows a street view – in other 

words, it allows you to zoom all the way in on the feature as though you were on the 

ground. Lastly, the vertical slider bar with plus (+) and minus (-) signs is also used for 

zooming in and out.  

 

Ditigitsing a point feature  

To digitise a point feature, simply select the “Add Placemark” button. A New Placemark 
dialogue window will appear, while the placemark flickers on the map. In the dialogue 

window, you can give the placemark a name and below it is the geographic 

coordinates of the point (longitude and latitude).  

 

At bottom of the “New Placemark” window there are 4 tabs – Description; Style, 

Colour; View and Altitude – which can be altered to your preference. Under 

“Description”, you can type in any information relating to the feature in question. You 

can also add a link, a web image, or a local image as references for the point you are 

creating. The “Style, Colour” tab allows you to change the colour, scale (size) and 

opacity (%) of the point label as well as the icon (symbol).  
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The “View” tab shows metadata such as longitude and latitude of the point, range, 
heading, tilt as well as date and time. The “Altitude” tab shows the altitude of the point 

- the drop-down menu next to altitude lets you choose whether altitude is measured 

from the ground, sea floor, relative to ground, relative to sea floor or absolute. Do not 

click OK or cancel on the dialogue window until you have named the feature and 

placed it in the right position. Use the mouse to move the placemark to its appropriate 

position while the dialogue window is open.  
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Digitising a line / linear feature 

Lines are made of a series of connected points from the starting to the finishing point. 

To create a line feature, select the “Add Path” button and a “New Path” dialogue 
window will pop up. Follow the steps above to give the path a name, change symbol 

colour, and view metadata. When drawing a line, use one left click to place a point. If 

you wish to remove a point that is misplaced, right-click on the point and it will be 

removed. Place points subsequently along the linear feature until the end, before 

clicking OK on the New Path dialogue window. Red dots show how far you have come, 

and the blue dot shows the last point digitised (so you know where you left off). To 

end, double-click on the last point. The spacing between your points will depend on 

the shape of the line feature. Sharp curves require more and closely spaced points for 

a smooth curve. Straighter lines can have fewer points.  

 

 

Digitising a polygon 

Polygons are made of a series of points that are connected sequentially and such that 

the last point meets the first point. To create a polygon feature, select the “Add 
Polygon” button and a “New Polygon” dialogue window will pop up, follow the steps 
above. Follow the steps above to give the polygon a name, change symbol colour, 

and view metadata, it is the same as for a line or point. Change the opacity of the fill 

to 0%, this will allow you to see what you are trying to digitise on the satellite image. 

Remember to double-click to end digitising.  
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Once you have digitised all of your desired features, you can view them together using 

different colours, as shown below. In case you closed the properties dialogue before 

you finish digitising, you can edit it later by right clicking on the feature (“Places” tab) 
and select “Properties”.  
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Saving Digitised / saves places as KMZ/KML files 

To save your newly digitised places, 

go to “Places” on the left panel, scroll 
to your desired place, right click on it 

and select “Save Place As”. A 
windows file explorer will pop up so 

you can navigate to the location 

where you wish to save your data. 

Note that the format of the file is 

“Kmz(*.kmz). This is a standard 
format for all Google Earth features.  

 

 

 

Importing KMZ/KML files into QGIS 

Simply drag the (kmz) file and drop it onto QGIS window!   
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Appendix B: How to use QGIS  

 

What is QGIS? 

QGIS is an Open Source Geographic Information System. This means QGIS is free 

software, making GIS available to anyone with access to a computer.  

This user guide takes you through the step by step process needed to complete the 

activities in SAEON’s Training Manual for Geographic Information System (GIS). If 

you wish to learn more than what is in this training manual there are many user 

guides and training manuals on QGIS at https://docs.qgis.org/3.4/en/docs/  

Installing QGIS 

You can download QGIS using the following link: 

https://www.qgis.org/en/site/forusers/download.html. Download the QGIS 

Standalone Installer from the long term release repository. This manual is based on 

Version 3.4.  

After downloading the setup file, open the file and install the software simply clicking 

“Next” for all dialog options. 

QGIS is open source software and is therefore continually updated. Different 

versions may look slightly different, but the basic processes remain the same. You 

can download older versions through the “all releases tab”.   

Activity Three  

Activity 3.1 in the Training Manual demonstrates the concept of layers using 

transparencies.  

3.2. Now perform the same tasks using QGIS software on a computer instead of using 

transparencies.  

3.2.1. Set the layers.  

3.2.2. Identify which province has the most number of district municipalities? 

3.2.3. Identify which province has the least number of district municipalities? 

Think about what information you need to answer the questions of which province 

has the most and least number of district municipalities.  

Information you will need: 

 Provinces of South Africa 

 District Municipalities of South Africa 

 

You can also freely download many of these spatial data sets for yourself if you want 

to create different maps. 

 

  

https://docs.qgis.org/3.4/en/docs/
https://www.qgis.org/en/site/forusers/download.html
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3.2.1 Set the layers  

Before adding a layer, you need to decide whether your data is represented as a 

raster or a vector. The vector format indicates the location and shape of features and 

boundaries, in the form of a point, line or polygon. While raster data has a grid based 

format or can be a photograph.  

What data format do you think the provinces and district municipalities will be? 

a) Both the provinces and district municipalities will be vector data as they 

represent boundaries in the form of a polygon.  

Adding a vector layer for activity 3.2.1: 

Once you have opened QGIS, click on Layer -> Add Layer, and Add Vector Layer              

or press Ctrl + Shift + V.  

 

This will bring up the Data Source Manager|Vector dialog box below. 

 

a) Make sure the Vector tab is selected 

b) Select file 

c) Click Browse   

d) Search for the layer you would like to add (In the case for Activity 3.2, this will 

be “Provinces.shp”) and click open to on your selected file.  

 

 

 

 

c) 

d) File 

a) 

e) 

b)  

A shapefile, a geospatial vector format, must have at least three extensions (“.shp”, “.shx” 
and “.dbf”). When adding your shapefile in QGIS make sure you select the file with the 

extension “.shp”. If you select the wrong file extension you may get an error message 

“invalid data source”. This is because you want QGIS to draw you shapefile and “.shp” is 
the main file and contains the information about the geometry and shape of the features. 

Whereas, “.shx” is an index file and “.dbf” stores that attribute information.  
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e) Once your file/files are selected as the vector dataset(s) click Add.  

The data you selected will now load. The Provinces of South Africa has now 

been added to the Layers Panel and its features have been drawn.   

 

To add the local municipalities’ layer, follow the same steps as above to add a vector 

layer, except in step e) select “District_Municipalities.shp”.  

As you can see there are now 2 layers (District Municipalities and Provinces) in the 

layers panel.  

 

Alternatively, you can simply drag and drop the file that you are wanting to open (eg. 

Provinces.shp) from File Explorer or your browser onto the QGIS window.  

 

 

 

Layers 



43 

 

 

Adding a raster layer: 

One of the transparencies you were given is a raster and is a satellite photograph or 

base map of southern Africa. While we don’t need the base map to answer our 
question, it is nice to know how to add one.  

To add a raster layer, click on Layer -> Add Layer, and Add Raster Layer              

or press Ctrl + Shift + R.  

This will bring up the Data Source Manager|Raster dialog box below. 

 

a) Make sure the Raster tab is selected 

b) Select file 

c) Click Browse   

d) Search for the layer you would like to add (In the case for Activity 3.2.1, this 

will be “Africa_basemap”) and click open on your selected file.  

e) Once your file/files are selected as the vector dataset(s) click Add.  

The data you selected will now load. The Basemap_Africa has now been 

added to the Layers Panel and its features have been drawn.  

 

 

Changing the order of layers: 

As you can see in the Layers Panel you have added the District Municipalities and 

the Provinces layers (you may also have added the base map). But you cannot see 

the Provinces shapefile, because it is below the District Municipalities.  

To fix this problem you can click on the Provinces layer in the Layers Panel and 

drag it above the District Municipalities layer.  

You should now see the Provinces layer above the District Municipalities layer in the 

Layer Panel and Provinces drawn on the canvas.  

c) 

d) File 

a) 

e) 

b)  
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Changing the colours of a layers: 

Right click on the layer you want to change the colour (Provinces) of and select 

properties. Alternatively, you can double click on the layer (Provinces).  

 

This will bring up the Layer Properties dialogue box.  

 

a) Make sure the Symbology tab is selected 

b) Make sure the Single Symbol is selected 

Layers 

d) Click on the colour drop 

a) 

h) 

b)  

c)  
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c) Select Fill. If you select Simple fill you are able to change the fill and line 

colour.  

d) Click on the Color drop down menu    

e) This will open the Select Color dialogue box. You can select any colour by 

switching between the tabs at the top and the colour options below.  

f) For this activity, we want the Provinces of South Africa to have a transparent 

fill (so we can see the layers below). To do this change the Opacity to 0%.  

 

g) Once you have selected your colours click OK.  

h) This will bring up the Layer Properties dialogue box again. Click OK to 

change the colour of your layer.  

 

Now that you have made the fill colour on the Provinces layer transparent, you can 

see the District Municipalities layer below. It is difficult to see the outline of the 

different provinces, as the line (stroke) is the same for both layers.   

 

Now that you know how to change the fill colour of a layer change the fill colour of 

the District Municipalities layer to blue. To do this follow the same steps as above, 

f) Change the 

opacity to 0% to 

make the layer fill 

g) 
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except open the Layer Properties of the District Municipalities instead of the 

Provinces layer.  

To make the province boundaries more clear, we can change the line (stroke) colour, 
width or style. For this activity, we are going to increase the width of the line to make 
the province boundaries clear.   
 

Changing the line width of a layer: 

 This process is very similar to changing the fill colour of a layer above.  

Right click on the layer you want to change the colour (Provinces) of and select 

properties.  

Alternatively, you can double click on the layer (Provinces).  

 

This will bring up the Layer Properties dialogue box.  

 

a) Make sure the Symbology tab is selected 

b) Make sure the Single Symbol is selected 

c) Select Simple Fill. This will give you options to change the stroke (line) 

colour, width, and style, which were not available under Fill.  

d) Change the Stroke Width to 1    

e) Click OK to change the line width of your layer.  

 

How to zoom in and move around the map: 

You may want to move around your map and zoom in or out to specific areas.   

To zoom into South Africa only, right click on that on the layer (Provinces) and click 

zoom to layer.  

a) 

e) 

b)  

d) Change the Stroke width to 1 

c)  
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Alternatively, use the magnifying glasses to zoom in  (+) by drawing a block 

around where you want to zoom into or to zoom out using  (-). 

Select the Pan Map icon  to help you move around the map.  

 

 

 

Now that you have set your layers and can draw colourful maps of your choice, we 

can answer the questions on the number of district municipalities in each province.  

Check the coordinate reference system: 

Before we start with any analysis we need to make sure that the layers we have 

added are in the same and an appropriate co-ordinate reference system (CRS).  

The choice of coordinate reference system is dependent on the choice of your region 

that you are working in and the type of analysis that you intend on doing. A popular 

CRS is WGS84(World Geodetic System 1984) which is used in GPS and has great 

accuracy.  Activity 4, where you created bufers at differnet distances from the river) 

you need to use a projected cordinated system. Universal Transverse Mercator 

(UTM) is s common CRS to use as it broken up into different zones, to aviod much of 

the distrortion of angular confimoity, distance and area. While South Africa can be 

broken up into different zone, UTM zone 35S is appropiate to use when wanted to 

measure features that span the entire country.  

You can find out more at: 

https://docs.qgis.org/3.4/en/docs/gentle_gis_introduction/coordinate_reference_syste

ms.html  

Zoom in  
Zoom 

Pan Map  

Zoom to Layer  

https://docs.qgis.org/3.4/en/docs/gentle_gis_introduction/coordinate_reference_systems.html
https://docs.qgis.org/3.4/en/docs/gentle_gis_introduction/coordinate_reference_systems.html
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 To check the CRS, right click on the layer - > Properties to open the Layer 

Properties dialogue box. Select the Information tab to view information 

including the CRS of the selected layer.  

Both the District Municipalities and Provinces Layers are in WGS 84. We will 

learn how to change.  

 

3.1.2) Identify which province has the most number of district municipalities? 

To answer this question, we need to know how many districts are in each province. 

There are multiple ways that we can go about finding the answer.  

I. We could manually count how many districts there are in each province, as 

was done in 2.1.2.  

II. Alternatively, we could ask QGIS to select the districts within a certain 

province. This is known as selection by location.  

III. In QGIS you are also able to update the attributes data. We can add a column 

to the attribute data of the district municipalities to indicate which province 

each district municipalities are in.  

Select by location (within)  

Let’s start by looking at how many district municipalities there are in the Northern 
Cape.  

a) Select the Provinces layer by clicking on it in the Layers panel  

b) Select the Select features by area or single click icon . This icon 

allows you to select a feature that you click on.  

 

c) Click on the Northern Cape province. The province should go yellow (as in the 

image below) to indicate that it is selected.  
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Now that we have selected the Northern Cape province, we want to select all the 

districts within that province. QGIS has a plugin (a feature) that you can add to do 

this job, called Select Within . 

I. Click on Plugins and select Manage and Install Plugins… 

 
II. This will open the Plugins dialogue box.  

III. Select Install from ZIP 

IV. Click Browse   

V. Search for the plugin you would like to add (SelectWithin-0.4 in the ZIP file) 

and click open to on your selected file 

 Alternatively, if you are connected to the internet. Select the All tab. 

Search for Select Within, click on the Select Within.  

b) Select features 

by area or single 

click  

a) Select the 

Provinces layer  

c) Click on the 

Northern Cape to 

select it  
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VI. Click Install plugin. 

 

Now that the Select Within plugin is installed, we can use the function to help 

us answer our questions 

d) To use the select within plugin click on Vector -> Select Within ->  

Select Within 

 

e)  This will open up the Select Within dialogue 

box (below).  

f) We want to select all features from District 

Municipalities that are within the selected 

features in Provinces (the Northern Cape).  

a. You can change what layer is selected 

by clicking on the drop down menu  

b. Make sure that Using Selected 

Features is selected. If not it will 

select the district municipalities that 

fall within will the whole of South 

Africa, not just the province we are 

looking at.  

g) Click OK 

 

 

 

 

iii) Select the 

Install from ZIP 
iv) Browse 

vi) Install Plugin 
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h) To see what district municipalities that have been selected because they are 

in the Northern Cape, we can open the Attribute Table for the District 

Municipalities layer.  

a. Right click on District Municipalities layer and click on Open 

Attribute Table.  

 
i) The attribute table shows information about each feature in that layer. For the 

District Municipalities layer, the attribute table tells us the district name 

(District_N). The top of the attribute tells us that there are 52 district 

municipalities, five of which are selected and within the Northern Cape.  

j) From the filter drop down menu, select Show Selected Features. Now we 

can see which district municipalities are within the Northern Cape. You should 

only see five rows.  

 

 

 

 

 

 

 

 

 

 

 

 

 

k) Now that you know how to select based on a location (for district 

municipalities within a selected province), complete the table below and count 

the number of district municipalities in the other 8 provinces.  

a. Follow steps a – j, selecting a different province each time in step c to 

complete the table 

  

i)  

j)  

Filter dropdown menu  
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Province Number of district 
municipalities 

Northern Cape  
Western Cape   
Eastern Cape  
Kwa-Zulu Natal   
Free State  
Gauteng   
North West  
Mpumalanga  
Limpopo  

Using attribute data 

Now we are going to answer the same question of how many district municipalities 

are in each province using a different approach. You may have noticed that the 

attribute table of the District Municipalities layer has which province each 

municipality is in.  

a)  Open the attribute table for District Municipalities. Right Click on the layer 

-> click on Open Attribute Table.  

b)  In the attribute table, select the Select/Filter features using form 

 (CRL + F). So the attribute table looks similar to below.  

c) Next to the Province heading, we are going to search for NC (Northern Cape). 

Options will appear as you start typing.  

d) Click on Select Features.  

e) You should notice that the top of the attributes table now reads, Selected: 5. 

You can also check on your map if the select features are in the correct 

province.  

 
 

  

e)  

b)  Select/Filter 

c) Type the Province 

code that you want to 

select by here  

d)  
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f) Follow these steps to complete the table below and see how many municipal 

districts are in each province 

  

Province Province 
code 

Number of district 
municipalities 

Northern 
Cape 

NC  

Western Cape  WC  
Eastern Cape EC  
Kwa-Zulu 
Natal  

KZN  

Free State FS  
Gauteng  GT  
North West NW  
Mpumalanga MP  
Limpopo LIM  

 

 

Using the table created above answer the following questions: 

3.2.2 Identify which province has the most number of district municipalities? 

Answer: _______________________________ 

3.2.3 Identify which province has the least number of district municipalities? 

Answer: _______________________________ 

 

Activity 4 

Activity 4.1 in the Training Manual demonstrates the concept of buffering using 

transparencies. Now we will perform the same tasks using QGIS software on a 

computer instead of using transparencies.  

4.2. When farmers use river water to irrigate their fields, the further away from the river 

the field is, the more expensive it is to water that field. Using the shapefiles 

provided and QGIS answer the following questions.   

4.2.1. How many circular fields are within 500m of the river? 

4.2.2. How many circular fields are within 1km of the river? 

4.2.3. Which Buffer (500m, 1km or 2km) contains the most circular fields? 

4.2.4. The fields of which Buffer are going to be the cheapest to pump water to? 

4.2.5. The fields of which Buffer will be the most expensive to pump water to? 
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Set the layers 

Think about what information we will need to answer these questions.  

Load to following layers: Activity4_basemap (raster), Circular_fields (vector) and 

River (vector) 

Change the symbology to make the River blue with a line stroke of 1mm and the fill 

colour of the Circular_fields green.  

To answer the questions, we need to create buffers around the river and count how 

many fields are in each buffer.  

We need to make sure that the Coordinate Reference System (CRS) that our layers 

uses are in the unit meters, as we need to create buffers of 500m, 1km, and 2km. 

Therefore, it is important to pick the correct CRS.  

How to change the Coordinate Reference System (CRS)/ projection? 

We are going to change to CRS to WGS 84 / UTM zone 35S. This is a 

CRS/projection that is commonly used for South Africa and the units are in meters.  

a) Right click on the River layer (the layer that you want to change the CRS of).  

Click on Export -> Save Feature As... to open up Save Vector Layer as…  

 

b) Make sure the Format is ESRI Shapefile  

c) Make your File name: River_m. Use Browser to find a place to save your new 

shapefile 

 

  

d)  

b)  

g)  

e)  

f)  

c) Browse  
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d) To the right of CRS click on select CRS  to open the Coordinate 

Reference System Selector 

e) In the filter bar search for WGS 84 UTM 34S 

f) Select WGS 84 / UTM zone 34S (as you can see the units are in m). Click OK 

to select this as the CRS.  

g) Click OK in Save Vector Layer as… to save the Layer with the new CRS.  

h) The new layer will now be added to your layer’s panel.  

 

Now convert the Circular_fields to the same CRS as River_m and name the new 

shapefile River_m.   

 

4.2.1. How many circular fields are within 500m of the river? 

Answer: _______________________________ 

Now that our layers are in an appropriate CRS, we can create a buffer to answer this 

question.  

a)  To add a buffer, click on Vector -> Geoprocessing Tools, and Buffer…            

 
 

b)  Select River_m as the Input Layer, as we want to create a buffer around the 

river.  

c) Set the Distance to 500 and make sure the units is in meters.  

d) Select Dissolve results, so the buffer is one feature and easier to work with 

later. 

e) Under buffered, click Browse   and select Save to file…  
f) Select where you want to save your new buffer and name it 500m_buffer. 

Make sure that you save it as a SHP file (.shp).  

g) Click Run.  
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h) If your 500m_buffer layer is not added to the layer panel, you will have to add 

it using Layer -> Add Layer, and Add Vector Layer.  

i) Change to opacity of the 500m_buffer layer to 50% 

Right click on 500m_buffer layer-> Properties -> Symbology.  

 

 

 

 

 

 

 

 

 

 

 

Now that we have created our 500m buffer we need to know how many fields are 

completely within this buffer. We will use Select by Location for this.  

j) Vector -> Research Tools -> Select by location  

  

  

b)  

e) Browse and save as 

500m_buffer.shp 

c) set distance to 

d) tick dissolve 

g)  

c) units in meters 
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k)  In Select by Location.  

Select features from Fields_m  

Tick where features are within. This will select the fields that are completely 

inside the buffer.  

By comparing to the features from 500m_buffer 

Select create new selection 

l) Click Run 

 
m) Open the attribute table of Fields_m to see how many fields have been 

selected.  

Right click on the layer (Fields_m) - > Open Attribute Table 

4.2.2. How many circular fields are within 1km of the river? 

Answer: _______________________________ 

Now create a 1km buffer around the river and count how many are found within this 

buffer. Use the same procedures as above.  

 Make sure in step c you use 1km or 1000m as the distance 

 Call this layer 1km_buffer 

 Make sure you select the correct buffer when selecting by location  

4.2.3  Which Buffer (500m, 1km or 2km) contains the most circular fields? 

Answer: _______________________________ 

Now create a 2km buffer around the river and count how many are found within this 

buffer. Use the same procedures as in 4.2.1.  

  

l)  
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Now that you have all three buffers and have the number of fields within each 

complete the table below. Use this table to help you answer 4.2.4.  

Buffer size Number on fields 
500m   
1km  
2km  

 

4.2.4 The fields of which Buffer is going to be the cheapest to pump water to? 

Answer:_____________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________ 

4.2.5 The fields of which Buffer will be the most expensive to pump water to? 

Answer:_____________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________ 
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Appendix C: Images for paper-based activities 

  

Image for activity 2 
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Images for activity 3 
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Images for activity 3  
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Images for activity 3 
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Images for activity 4 
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Images for activity 4 
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Images for activity 4 
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Images for activity 4 

 


